ESNA WELINK
TM
CONFERENCING
Installation and User Guide

Version 10.1 (3) | Oct 2015

ESNA WELINK CONFERENCING
INSTALLATION AND USER GUIDE
This guide covers the guidelines to be followed when deploying Esna WeLink Conferencing. The User Guide portion
provides the end user with basic instructions to follow on using the product. The Installation Guide is intended for
System Administrators who will be setting up and managing the Esna WeLink Conferencing hardware and software.

Contacting Esna™
Esna Technologies Inc.
30 West Beaver Creek Rd., Suite 101
Richmond Hill, ON. CANADA L4B 3K1
Tel: +1 905-707-9700
Fax: +1 905-707-9170
Website: www.esna.com
For hardware and software support, contact:
Tel: +1 905-707-1234
E-mail: techsupp@esna.com
For documentation requests and feedback, contact:
E-mail: documentation@esna.com

Copyright & Trademarks
Esna Technologies Inc.
30 West Beaver Creek Rd., Suite 101
Richmond Hill, ON. CANADA L4B 3K1
Copyright © 1992-2015 by Esna Technologies Inc. All rights reserved.
Esna WeLink Conferencing is made available under the terms of the Esna Technologies Inc. license agreement without
express or implied warranties of any sort, including specifically, any warranties relating to the performance or
maintenance of the program.
While every effort has been made to ensure accuracy, Esna Technologies Inc. will not be liable for technical or editorial
errors or omissions contained within the documentation. The information contained in this documentation is subject to
change without notice.
Esna software and related documentation may be used only in accordance with the terms of the Esna Technologies Inc.
license Agreement and copied only to provide adequate backup protection.
Other brands and products are trademarks or registered trademarks of their respective holders and should be noted as
such.
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USER GUIDE
Ch. 1 - User Guide

Introduction
Esna WeLink Conferencing allows users to have a conference call or a voice meeting over a pre-existing telephone
system. Once all the server side configurations have been completed by the system administrator, the person who has
the Moderator access code will have the ability to control the different rooms in the conference system. The Moderator
can be seen as the conference room’s chairperson who has the ability to invite other participants to the conference. The
Moderator may also modify different types of settings that are related to the conference rooms such as the recording
functions or the background music.
This guide is intended for the end-users of the Esna WeLink Conferencing.

Maximum Number of Participants
There are 3 types of participants within Esna WeLink Conferencing: Moderators, Speakers, and Listeners.
Moderator (Chair): The moderator creates the conference room. The moderator also controls access to the room,
who can speak, and when.
Speaker (Attendee): These participants can listen to the conversation, and can contribute through voice input.
Listener: Participants who are listeners can hear what is said, but cannot themselves speak in the room.
Esna WeLink Conferencing supports up to 100 channels (total simultaneous participants) across all rooms.
A single conference room can have up to 100 participants, providing no more than 50 are speakers. All other participants
must be listeners only.
For example:
MAXIMUM PARTICIPANTS - ONE ROOM
Moderator

1

1

1

Speaker

49

25

0

Listener

50

74

99

Total

100

100

100

MAXIMUM PARTICIPANTS - MULTIPLE ROOMS
Room Number

1

2

1

2

1

2

3

Moderator

1

1

1

1

1

1

1

Speaker

10

0

30

9

9

9

9

Listener

39

49

59

0

30

20

20

Total

100

100

100

There is no limit to the number of conference rooms that can be created, providing the total number or participants from
all rooms does not exceed 100.
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Access Codes (Logging into Conference Server)
Esna WeLink Conferencing can have multiple rooms active by default. Your system Administrator can add more rooms
and also change the maximum number of participants in each of the rooms. The system Administrator also assigns the
access codes, which are currently set as follows:

●

Room 1 - ___ participants max.
Moderator access code: __________
Participant access code: __________

●

Room 2 - ___ participants max.
Moderator access code: __________
Participant access code: __________

To enter a room simply dial the number for the conference server then enter the access code you are given. For example,
if you are the Moderator of the room and are given the access code 1111#, enter the code once you are connected to the
conference server. The server will automatically send you to your room and grant you Moderator authority.
The process is identical for both participants and listeners. The only difference will be the access code that they are given.
Since the access codes themselves are associated with the conference room, there is no need to specify which main
conference room you wish to join.
Warning: When dialing into the conference server from outside the company, you must dial the conference
server’s external number directly. Do not connect through the auto attendant or you may not be connected.

Conference Room Navigation
While the main conference rooms are determined by the access code, you will have the ability to enter the side rooms off
the main conference room.
Each conference room has 4 side or private rooms to allow a side conference. The following codes can be used to access
each of the private rooms:
51# enter side conference room 1
52# enter side conference room 2
53# enter side conference room 3
54# enter side conference room 4
50# to return to the main conference.
Main Room

Moderator

Side Room 1

Side Room 2

Participants / Attendees

Side Room 3

Side Room 4
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Moderator’s Functions
The moderator has administrative rights inside a conference room.
Note: Moderators also have access to Speaker’s Functions on page 8.

Invitation
The Moderator can invite participants to the conference. Please view the following example to get an idea of how the
procedure takes place.
1.

Press 2# from your telephone. You will be prompted to enter a number.

2.

Enter the full number (at this time, there is no dial plan logic or contact integration), including a leading 9, and a call
will be placed to the number.

●
●

If the call is unsuccessful, the chairman will hear a prompt indicating the failure.
If the call is successful the participant will be added to the conference room.

Moderator

Moderator may
invite to the main
or side room

Attendee

Note: This whole process is silent to the other participants so you don't have to worry about them hearing
the digits pressed.
Note: You can also enter a side or private room and then invite a participant if you wish to prep them on
the call before joining the main conference.
Note: To cancel an invitation call in progress, the Moderator can enter 20#.

Additional Moderator Functions
30# - Turn off background music
31# - 39# - Change background music ( 1 - 9 ), also enables music if it has been turned off.
71# - Recording off
81# - Recording on
72# - Announcements off
82# - Announcements on
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Speaker’s Functions
These are the basic functions available to a speaker.
41# - Plays your Party ID, i.e. if you were the first caller it would play 1.
42# - Plays your Caller ID, i.e. the phone number you called from
43# - Plays the number of parties currently in the conference
44# - Plays the maximum number of parties for this conference
88# - Mute
78# - Un-Mute
21# - Hand off Call to another number
9# - A help file outlining the options will be played (currently this file is not available)
0# - Return to main menu
Note: Played messages are only heard by that caller, and not by the whole room.

Listener’s Functions
Listeners do not have any functions available to them.

Added Functions for Esna Officelinx Integration
These are the advanced functions available in Esna WeLink Conferencing.

●

Play Caller ID of Participant: The Caller ID information is used to identify the participant when he/she enters the
conference room.

●

Integration with contacts: The Caller ID can be crossed referenced with the contact list to name the participant
automatically based on the information.

●

Speaker Marker During Record: This feature automatically creates a marker on the recorded file which allows you
to see who was speaking at any given moment.

●

Transcribe Conference Option: This feature allows you to send the recorded conference call to the transcription
service so that you can receive a printout of the conversation.

●

Conference Report: This feature creates a log of all conferences and their participants (Who joined, when they
joined, when they left).

●

E-mail Summary Report: This feature automatically sends a log to the conference organizer. The information
included in the log includes the number of participants, their caller id, and the duration of the conversation.
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INSTALLATION GUIDE
Ch. 2 - Installation Guide

Esna WeLink Conferencing License
In order to run the Esna WeLink Conferencing, you must obtain a license from an authorized dealer. It is recommended
that you have an Internet connection on the computer that will host Esna WeLink Conferencing. The License requires an
Internet connection to activate the conference server upon installation.

License Expiry Notice
When the license for Esna WeLink Conferencing is about to expire, the server will play a prompt for the moderator upon
login as a reminder. This prompt is only played for moderators. Participants and listeners will not hear the notice.
The notice is played under following conditions:

●
●
●
●
●

30 Days before Expiry
15 Days before Expiry
7 Days before Expiry
1 Day before Expiry
The day of Expiry

When the license expires, no users will be able to connect to the conference server. To ensure seamless usage and
integration of Esna WeLink Conferencing, contact your dealer regarding license renewal as soon as possible.
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License Activation
Requirements
●
●
●

Internet Connection
Site UID
Serial Number

Warning: If you are installing the conference server on an Officelinx system, ensure that you are not running
the Officelinx License Upgrade program when managing your license. You should always confirm that you are
running the Conference Server license program.

Procedure
1.

Contact your dealer and place an order. Once the order is finalized you will receive two codes. First is the Site UID,
and the second is the product Serial Number.

Warning: Site UID and the Serial number are vital and confidential. Keep a record of these numbers in a safe
place.
Note: You can install the Esna WeLink Conferencing without the license. You are free to load your license at
a later time if it is unavailable during installation. Once you do install the license onto your system, you
must restart the UC Conf Server service from 
Control Panel > Administrative Tools > Services.
2.

Download the Esna WeLink Conferencing installation program by using the
link provided by your dealer. During the installation, or when you run the
license upgrade program separately, you will be prompted with the following
window. Enter the information in the highlighted area then click on the
Request Online Activation button.

Warning: An Internet connection is required to activate the license.

3.

The license is now active on the server computer.

Hint: For detailed instructions, refer to page 11.
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Esna WeLink Conferencing Installation
Note: You can install the Esna WeLink Conferencing without the license. You are free to load your license at
a later time if it is unavailable during installation. Once you do install the license onto your system, you
must restart the UC Conf Server service from Control Panel > Administrative Tools > Services.
Warning: If you are upgrading Esna WeLink Conferencing from an older version and have made changes on
the SIP Configuration Tool during initial installation, you must select the template for your PBX again from the
SIP Configuration Tool so that the settings are refreshed during the upgrade. All of your previous channel/
extension settings and room settings will remain even if you reselect the template. After re-selecting the
template, you can modify the entries to fit your needs. This is particularly important for Iwatsu systems.
Warning: By default, Esna WeLink Conferencing uses port 50060 for communicating with the PBX (different
from the 5060 default of Esna Officelinx to avoid conflict). While this does not affect the configurations of
most sites, it may be necessary to allow access to that port through network security. Be particularly aware of
port usage on sites that have a Dialogic Media Gateway, since that port is often blocked by default.
Warning: When dialing into the conference server from outside the company, dial the conference server’s
external number directly. Do not connect through the auto attendant or you may not be connected.

Requirements
●

Microsoft Windows Operating System (2003, XP, Windows 7 (32 and 64-bit), Server 2008, Server 2008 R2 (64-bit),
Server 2012 (64-bit) Standard Edition)

●
●
●
●

Microsoft .Net Framework 2.0 (this is included in the Esna WeLink Conferencing installer)
SIP Integration
Internet Connection (for license activation)
Esna WeLink Conferencing supports up to 100 channels.
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Step-by-Step Installation Instructions
1.

Locate and run the Esna WeLink Conferencing installation file. 
The following screen will appear. 

Click Next to continue.











2.

Click Next to start the installation.




3.

The installation will begin.















4.

At this point, if you do not have Microsoft .Net Framework 2.0 on your system,
the Esna WeLink Conferencing installer will automatically add it. This process
may take a while.
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5.

During the installation, the SIP Configuration Tool will appear.
Configure SIP to reflect your own system. Most fields will be
automatically populated if you used the provided templates available
under the File menu. 

Esna WeLink Conferencing supports up to 100 channels.

Once all the fields are completed, click on the Conference option from
the left menu.

Warning: If you are upgrading Esna WeLink Conferencing from an
older version and have made changes on the SIP Configuration
Tool during initial installation, you must select the template for
your PBX again from the SIP Configuration Tool so that the settings
are refreshed during the upgrade. All of your previous channel/
extension settings and room settings will remain even if you
reselect the template. After re-selecting the template, you can
modify the entries to fit your needs. This is particularly important
for Iwatsu systems.
6.

You can configure the conferencing settings here. This section is
particularly important when integrating with the Officelinx system.
The other field that will be commonly used is the Language selector.
The language defined here will change the prompts that are played for
the users when they dial into the conference server. For example, if
you choose Japanese, the default prompts that the users will hear
right after they dial into the conference server will be in Japanese.
Please note that you must assign a language to the rooms separately
if you want the prompts inside the rooms to be set to a different
language. Configure the remaining fields as required then click on the
Rooms option from the left menu.











7.

You will be able to configure your conference rooms here. Enter the number of rooms that you will be using and
configure each room accordingly. Click OK when you are finished. Each of these options is detailed below.

●
●

Max Parties: Maximum number of participants that can be in the room simultaneously.
Chairman PIN: Password required for Moderator Access.
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●
●
●

Listener only PIN: Password required for Listener Access.

●
●
●

Music: Choose the background music that is played when only 1 person is in a room.

Attendee PIN: Password required for Speaker access.
Mailbox: Enter the Mailbox that will receive the reports for the current room, this feature is only available with
Officelinx integration.
Announce: Make an announcement to everyone in the room whenever someone else joins the room.
Recording Type: Select from one of the following recording options,

●
●

Disabled: Recording the conference is disabled.
Automated (2 parties): Conference server will automatically record the session when two or more participants
are in the room.

●

Automated (2 parties one is chairman): Conference server will automatically record the session when two or
more participants are in the room, but one of the participants must be a moderator.

●

Manual: The moderator may manually start/stop the recording.

●

Language: Select the language for the current room. This selection will change of all the prompts played in the
current room to the language selected.

●

Access Type: This option determines how s are admitted to the room.

●
●
●

Anyone with PIN: s with a PIN will be immediately admitted to the room.
Chairman must be present: Conference participants can log in but will not be admitted to the room until the
Moderator also logs in. Until then, s will hear wait music and cannot communicate with each other.
Caller ID must be in the access list: (for future release) An INI file can be modified to add a list of telephone
numbers that are allowed access to this room. Any calls from numbers not on the list will not be allowed into
that room.

Note: Recording Type setting is unavailable for Iwatsu PBX systems.
Note: If there is no Esna Officelinx integration, the conference sessions that are recorded will be stored as
voice files under the conference server installation folder (c:\uc\conference\recording\roomX\ by default. 
X represents room number).
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8.

After the SIP configuration, you must add the license for the Esna WeLink
Conferencing server. An Internet connection is required to activate your
license.

●

Please refer to License Activation on page 10

Note: If you don’t have the license ready during installation, simply
click on the Close button to finish the installation without the
license. When you receive the license information at a later time, you
can update your license from the utility located at Start > Programs
> WeLink Conference Server > CS License Upgrade. Refer to
License Activation on page 10 for detailed information.

Warning: If you are installing the conference server on an Esna Officelinx system, ensure that you are not
running the Officelinx License Upgrade program when managing your license. You should always confirm
that you are running the Conference server license program.

9.

When licensing is complete, you will see the following window. Click
Finish to exit the installer.














10. You will be asked to restart the computer. 

Click OK to restart the system. 

The installation of Esna WeLink Conferencing is complete.
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Esna WeLink Conferencing Monitor
Overview
Esna WeLink Conferencing has a built-in capability to display the current status of the server through a web interface. By
logging into port 30060 of the conference server (e.g. http://192.168.1.100:30060), the technicians or the administrators
will be able to view live information regarding the server. The information available from the monitor is as follows:
List of rooms
Number of Users in each room
Recent activities of the room
Status of the room
Miscellaneous information regarding rooms
(e.g. Mailbox that it is attached to for Esna Officelinx integration, etc.)
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Monitor Screen
When you type in the correct address for the monitor, you will see a screen similar to the one below. Each row represents
a single room in the conference server while each column contains data specific to that room.

●
●
●
●
●
●
●
●
●
●
●
●

Listeners: This field shows the number of listeners in a room.
Speakers: This field shows the number of speakers (regular participants) in a room.
Total: This field shows the total number of people in a room.
Mbx#: This field shows the mailbox associated with room (for Esna Officelinx integration).
Started: This field shows the time at which the conference started.
Ended: This field shows the time at which the conference ended.
Locked: This field shows the locked status of the room.
Recording: This field shows if the room is currently being recorded or not.
AN: Announcement. This field shows if the announcements are on or off.
AT: Announcement Type. This field shows what type of announcements are being played.
PR: Private Rooms. This field shows if private rooms are enabled in the room.
PHP: Play Help Prompt. This field shows if help prompts are on or off.

When a room is in use, it will be displayed highlighted on monitor as you can see below. When the room is being used,
you will be able to see the number of users in that room and also see when the conference started.

When the conference is over the highlight will disappear. At this point the Ended status of the conference room will be
updated with the end time information so that you can see exactly when the conference started & ended.

You may also click on the room number to view the specifics of that room. This will provide you with the participant’s
information, such as Caller ID and name if the contact information is available in the Esna WeLink Conferencing
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integrated environment.
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Esna WeLink Conferencing FAQ
Licensing
Q: Can I use one Esna WeLink Conferencing license on multiple servers?
A: No. You must obtain a license for each server.

Q: Can I move the Esna WeLink Conferencing license to another server?
A: Yes, but you must obtain a new license for the new server from your dealer. The old license will no longer be valid. You
will be allowed one hardware change free of charge. The license will be reissued to accommodate your hardware change.
Subsequent hardware changes will incur an administration fee.

Q: What happens if there is a significant hardware change to the server?
A: You will be allowed one hardware change free of charge. The license will be reissued to accommodate your hardware
change. Subsequent hardware changes will incur an administration fee.

Q: Can I pay for the Esna WeLink Conferencing license month-to-month?
A: No, you must pay for the Esna WeLink Conferencing license a year at a time.

Q: Can I add more features to the Esna WeLink Conferencing license?
A: Yes. You may contact your dealer to upgrade your license for additional features. The license can be upgraded through
the License Upgrade tool once you receive the details from your dealer.

Q: What if I add more features midway through my 1 year term?
A: You will be charged for the 1 year term on any type of feature upgrade but it will expire at the same time as your
initial order.

Troubleshooting
Q: The server stopped working.
A: The most common causes are:

●

Sever Computer Crash: Restart the server computer. If the conference server isn’t functional after the restart,
consider one of the below scenarios.

●

No Internet Connection: Esna WeLink Conferencing requires an Internet connection for its online license.
Restore the Internet connection and the server should be functional soon after.

●

License Expiry: Esna WeLink Conferencing will cease to function when the license expires. Contact you dealer to
renew the product license.

●
●

License Conflict: The license is in use on another server. Contact your dealer.
Change in Server: The hardware / software on the server has significantly changed. Obtain an updated license
from your dealer.
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